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1) Differentiaste between NTFS & FAT.

MNTFS is the current file system wsed by Windows. It offers features like security permissions (to
limit other users’ access to folders), quotas (so one user can't fill up the disk), shadowing (backing

up) and many of her features that help Windows,

FAT32 s the older Microsoft Alesystem, primarily used by the Windows 9X line and Window could be

inst alled on a FATI2 parition up to XP, In compansion, FAT)2 offers none of whiat was mentioned
above, and also has & meEdmum FILE (not folder) size of 4GB, which |3 kind of small thess days,

espedally in regards toHD videa

2) What Is VOIP.

VOIP - Short for Volce Over Intemet Protocol, a category of hardware and software that enables

peopie to use the Internst as the transmission medum for lelephone calls by sending volce data in
padkets using 1P rather than by traditional droult transmissions.

1) What Is loop back

Loopback address is 127.0.0.1,

An address that sends ot going signals badk to the sam e computer for testing.

4) What |s Proxy Server.

A procy Server Lf & compilter that adls as a galew sy between a local network (£.9., &l the computers
at one oo pany of in one bullding) and & larger-scale netwark sudh as the [nternet, Proxy Servers
provide inceased performanioe and security. [n some cases, they monitor employees’ use of outside
FESOLIMCES.

§) Differentiate between FIREWALL/ANTIVIRUS.

Anthvlrus:
The prime job of an anivinug is proted your system from computer viruses. Your computer may be

st andalone or pat of network or conned ed to Internet you need an antivirus program. It actively
M onilors when you are using your system for any virus threst from different sources. i it Tound ane
it tries to dean or guaranting the virus ultimat ely keeping your system and data safe.

Flrewall:
Firewall is in cther hand a program which protecis your system from outsider/int ruder/hacker

attacks. These attacks may nof be virus type. In some cases hackers can take control of your system
remolely and steal your data or import ant information from system, If your system (s directly

conneded to intemet or a large network than you can inst all a software firewall in your PC to proted
Ry @ LR ey T e e e e e o




Interview Preparation - 17 Common Questons
P e s

Question My Answer

1. Elime sboutyoursel

2. Hae you had athermork
expenence?

What.dd youlke the mostorthe
least aboutyour previous wadk
expernces?

4. Whatdd youthink of your bows?

S. i ssked your elerence sabautyo,
what would they say?

6. Whatare your geawststengihs?
7. Whaae yourgeakst
weaknesses?

8 Howee you spendyouriesure
me?

. Whatschoolsubpets doyou le
mog?Lesst)

10. Whitabites mnd sk doyou hane
ihateige drectyfo e posson you
are apphng br?

11, Whatase the qualtes ofa good
engiayse n s organcaion?

12. Whatare you bng4em goals?

13, Whyare you appiying forthis
poston?

14, Why shoukd e you?

15. Doyouwork beterabneorna
group?

SSIS Interview Questions and Answers for Experienced
and Freshers

Hare we are publishing seres of posts on 555 Inteniew questions and antwars Part 4
for experenced and frashers. Below 15 the series 4.

Q. Difference between Union-all and Merge Join?

Ans:

+  Marge transformation can accept only two inputs whereas Union all can take morm
than twa inputs

* [Data has to be sorted before Merge Transfomation whereas Union all doesn't hawve
army condithon Like that.

Q. What is difference between Multicast and Conditional Split?

Ans:

The Multicast transformation distributes its input to one or more outpuls. This

transfermation is similar Lo the Conditional Split transformation. Both transformations

direct an input to multiple outputs. The difféerence between the two is that the

Multicast transformation directs every row to eveny output, and the Conditional Split

directs a row Lo a single output

Q. What is the difference between DTS and 55157
Ans .
Wall, nothing sxcept bath the Microsoft SOL Server Products.

Even though both are the ETL tools, we can differentiate if you are asked

abservations,
5.0 DTS 3515
Data Transfarmation
I seryicas s Server Integratlion hensicas
2 LEing Activex Script Lsing Scrigting Language
L Mo Dagrloyment wizard Deployment wizard
4 Livited Set of Huge of Transformations available

Thas arhcle provides latest ADD Net Internesw Questons and Answers for dot net developers wath
samngple code and detaled explanations on Dataast Dataroader, Datatable, DataView, Connection

ebject, Transactions, SQL Commands, Data adapter, Data Providers, Locking Connection pooling
md Connechon Stnng

1} What is ADD. NET ¥

ADO Hetis one of the magor component of Het Framewark, whach is dengned 1o connsct ta
databares like Oracle, MySQL, SQL Server, MS Access etc. and work with data stored in them

2} Explain Generic Features of ADD, Net 7

& A Med provides in buillt cisdse o comnect wilh Dalsbades W Oracle, WSO, S0OL Serser, S S00858 €
Provedes m Bal clagicd 1o do dsla manipulabion sperateznd ke e, Update, (eletr and Select data

Prowedes data prosiders Tor specdic database s for eflepent interactigng with BB Caamphe - QD8 Med provider Bor
Oracle

®  Tight integraticn with Xhig

Provedes funclionality 1o combane dstafrom dfferent dola sources
Cusconmected Data o chiflecluee Toe hebier perlermance

3) What are the isportant features of ADD Net 2.0 7
Bulk Copy Operation from ocre Data Source to another Data Sowrce

s  Bach Updste = Te wpdale i ns of iéwd in a dataliie bl in & ohgle call Trom & prograss thas by ivdsdeg
round trip Eo datsbace

Data Pageag — To resd dasta from & cemsn index

Comsectenn Detals — To get detaded @d g aboull commections ke buler ssfarmation, cuddad detads ebc
DataSet Remotingf crmak Propey = To minke datnse? derinhged in By

Patatsble s Load and Swve Methods — For XML sleractions

4) What are the namespaces used in ADONET for data access 7
Namespaces used to access database are

*  Syiem Data = Cormtaing all generic dats scod s classes

Syitem Date Comman = Conbamny clagies whish sre thared f owerridden by dots provederi
System Data OleOb - OLE OB provider dadse s wted 10 3ocess datasbade sudh a5 Drade MyS 3L, SO Server and
K Acceid

System Data Sgichent — Contany darees for 500 Server
System Data Sgllypes — Conbans SOL Server data bypes

) What are major difference betwemn classic ADO and ADO.NET 7

ADC
#  ADD Bve recordict
®  ADD ehjects communicate an Banary mode
®  ADD wpparts mosthy cennection ariented models
& Gieie ADD derrves i ormatesn about datas splicitly ot run bime based on metadats, il 15 ah espendive proceis
®  Only Chendt Side Curgars e allewred in ADD
ADOD. Net

Ms crm interview questions and answers pdf. Ms crm interview questions and answers. Ms crm interview questions. Ms crm interview questions and answers for experienced.

draobyek at ngissa ot nottub draobyek eht kcilC xob goid orcam drocer eht ni eman at orcam evig dna orcam droceR JA macro type to combinations of keyboard shortcuts ctrl+r and then click the Shareholder button, click the Close button to stop registration Choose Macro Stop Registration 14) a ¢ How to create cross references in Word 2013? To
delete a break in the column of which it is not necessary to click on the Show/ Hide button in the Home tab in the paragraph section to view unprotected characters click in the break section Press the Remove button from the keyboard, remove the break from Colonna 10) Is it how you can make a screen in Word 2013? To manage the setting of the
archive in MS Outlook, tap the tools from the main window, then click on the "Options" tab, open a window showing "Spelling" and "Other" click "" Another tab and select Auto -Cons Archive the window with all the options such as automatic execution, the prompt before the automatic archive runs, eliminate expired elements, archive or eliminate old
elements, etc. 6) & ¢ What are the shortcut keys to create the hypertext connection? Go to the insert in illustrations, click the icon with the camera click on the screen cutting option and choose the portion that you want a screenshot 11) is how to insert the caption in your image? 18) What is the short circuit to move the insertion point at the beginning
of the document? To create your filigree, the page layout tab has arrived on the background page click on Weinmark and select Personalized Witerk. Select the image or text filigree option and make changes accordingly. 3) Explain what the SMTP protocol is? To change the mail format in Outlook, touch the tools from the main menu, open a window,
select the options from the window open another window, showing the set mail and the format Mail - Click the Mail Format option Scroll down For a different format and select the format you want as rich text, normal text and html Click OK 13) Explain how you can manage the archive settings in Microsoft Outlook? 2) Explain what POP3 protocol is?
To connect with the on-screen cloud service2013 you have to go to a main menu, open a unit, click on the option, access the e-mail address and connect to the cloud 2 service) ,how can you enter videos in Microsoft Word 2013? To automatically delete the messages deleted in Outlook, open the folder in the IMAP account that you want to set up for the
purge of the automation Choose 9) Mention what is the shortcut to move on to the activities and switch to email in Outlook 20137? After clicking OK, now click Next, then click Finish, then click closer. 1) is it how can you connect with the cloud service on Word 2013? To customize the return amount, you need to select the text you want to return. 4)



Explain how to create an e-mail signature in a perspective? Go to the main menu, tap the Tools option and select the "Options" tab, open a window, in the preference tab; You will have the option, "e-mail" and "mail options". If you click on "E -mail", open another window in this window, you can choose the option and click on the check box as required
as "Permanently Eliminate and -mail Drawing" Take "Apply" and then click On "OK". If you have added the "Developer" tab in your main menu, then in this tab you have an "XML Mapping panel" option. This option helps to map the XML content in the Word document. The scrolling button to insert a page interruption is to press + 22) is what is the
simplest way to save a graph so that you can use it another document? Select any option from "type of reference" and then click Insert after bringing the cursor in which the new reference connection is created, pressing a ¢ avelop "Cntrl+Click" addressed to the reference object 15) It is as it is possible to limit the change for someone in question
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drop eht otni oediv tresni ot ?)locatorp ssecca egagasem tentni( pami tahw alpxe )1 fdp daolnwod egnahc Morf tnemucod eht edam edam sgnahc kcart eht tceles ,3102 d dgnah kcart tcejer ro tpecca ot .ylper ener of FO DAETNIW ROTIDDE STAYSSAM ENCER EHTBAH Uoy Woha &,)0 Image 17) & ¢ How can you customize the return amount? To move
on to the next message in MS Outlook 2013, you need to use the CNTRL+period. To set an e-mail AOL in Outlook account select Tools, from the account settings to the main menu in Outlook, visit the e-mail tab option and then click New Make sure that Microsoft Exchange, Pop3, IMAP or HTTP are selected Click your name type and enter your
complete AOL e-mail address click Next, and then make sure that the Internet email is selected click Next now select IMAP with the type of account with the type of incoming mail servers is & & establish "iIMAP.AOL.COM" under outgoing mail server (SMTP) to enter & ¢ avelop "SMTP.AOL.COM" Enter the AOL screen name under the Username and
then enter the AOL password tap more settings and go to the output server tab Make sure "my outgoing server" (SMTP) the authentication request is controlled now go to the "advanced" tab, with the type of door of server door is 4,— & “587 &iate for the outgoing server (SMT P). 16) Mention what is the connection to MS Outlook 2013 to move on to
the next message? In Outlook 2013, the new functionality includes the preview message in the list of messages: you can understand it from the list of messages itself, which message to read and what to ignore, since you can see a small description of the mail in the mailing list. A user registration form can help you create a document with a control
box, drop -down list, combined box and any other content control to create the user registration forms in MS Word 2013, go to the file tab selection options - do Click on customizza Ribbon Click on the check box for "Developer" this add the Developer tape tab to create the registration form, That you want a form that includes basic information such
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2021-12-10 - Here in this post I have compiled 65+ interview questions and answers for Power Apps, Power Automate, Power BI, Power Virtual Agents and many more on Power Platform. Check out the complete questions here: Explain about the Power platform echo-system?What are PowerApps and why do we use it?What i ... 2022-05-11 - 1) Explain
what is a class in C++7? A class in C++ can be defined as a collection of function and related data under a single name. It is a blueprint of objects. A C++4 program can consist of any number 2022-05-07 - In this list of ASP.NET interview question, there are most commonly asked basic to advanced ASP.NET interview question with detailed answers to
help you clear the job interview easily. We have covered 50 most important .NET interview questions for fresher candidates as well as .NET interview questions for experienced developers to help them prepare for the ... We hope these Power BI Interview Questions and answers are useful and will help you to get the best job in the networking
industry. This Power BI Interview Questions and answers are prepared by Power BI Professionals based on MNC Companies expectation. Stay tuned we will update New Power BI Interview questions with Answers Frequently. The Chef is one of the recent inventions that are truly appreciated by most of the organizations and so the demand for Chef
Professionals is increasing day by day. All these top 50 Chef Interview questions and answers are prepared by well-experienced recruiters in the Chef industry. Thus, aspirants who go through these questions will certainly crack their interview and get ...
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